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Chapter - 1 Computer Fundamentals 

  

Practice Zone: (Page no: 3) 

 1. Machine language is directly understood and executed by the computer. 

 2. The short words used in Assembly language for giving instructions are called mnemonics. 

 3. Portability is an advantage associated with the high-level languages. 

 4. C and C++ are two examples of high - level language. 

 

Practice Zone: (Page no: 12) 

 Classify the following under the following heads: 

 

Operating 

System 

Utility Software General 

Purpose 

Special Purpose 

Application 

Purpose 

Language 

Processor 

Android Disk Cleanup PowerPoint 2013 Billing System Assembler 

Mac OS Anti-virus 

software 

Adobe 

Photoshop 

Library 

Management 

System 

Compiler 

Linux Data 

Compression 

QuarkXPress Ticket 

Management 

Software 

Interpreter 

  Access 2013   
 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which type of software converts and executes the source code of a high-level language 

program line by line? 

  a) Compiler b) Interpreter 

  c) Assembler d) Operating System 

 2. A type of software that allows the source code to be accessible to the users and organizations 

are called  

  a) Proprietary software b) Open-source software 

  c) Desktop Publishing software d) Language Processors 
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 3. A software program that let us store large amounts of data in an organized manner and 

provides tools for searching data and generating reports based on conditions is called` 

  a) Spreadsheet software b) Desktop Publishing software 

  c) Graphic software d) Database Management software 

 4. Which among the following is the largest unit of measurement of memory? 

  a) Petabyte b) Gigabyte 

  c) Yottabyte d) Terabyte 

B.  Fill in the blanks using the words given in the box. 

 1. The operating system is an interface between the user and the hardware. 

 2. Proprietary software is a computer software for which there are restrictions on use, 

modification, copying or redistribution. 

 3. One petabyte is equal to 1024 Terabyte whereas one zettabyte is equal to 1024 Exabyte. 

 4. The utility software performs maintenance work on a computer system to help in its smooth 

functioning. 

 5. Ubuntu, an Operating System, is an example of open-source software. 

C.  Choose the odd one out. 

 1. Compiler, Assembler, Interpreter, Disk Cleanup 

 2. Linux, Windows, Android, Access 

 3. Billing System, iOS, Ticketing System, Inventory Control System 

 4. QuarkXPress, Photoshop, Antivirus, Excel 

 5. Mozilla Firefox, Openoffice.org Writer, Audacity, Adobe InDesign 

 6. Visual FoxPro, Access, Oracle, PowerPoint 

D.  State whether the following statements are True or False. 

 1. A computer can work without an operating system. -  False 

 2. Application software is used to control the operations of a computer. - False 

 3. High - level language programs have to be converted to machine language using an 

interpreter or compiler. - True 

 4. An antivirus program is an example of utility software. - True 

 5. Payroll software is an example of general purpose application software. - False 

E.  Convert the following decimal numbers to their equivalent binary number 

form. 

 1. (126)10 = (1111110)2 
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 2. (76)10 = (1001100)2 

 3. (172)10 = (10101100)2 

 4. (512)10 = (10000001000000000)2 

F.  Convert the following binary numbers to their equivalent decimal number 

form. 

 1. (111110)2 = (62)10 

 2. (110001)2 = (49)10 

 3. (1010011)2 = (83)10 

 4. (11101011)2 = (235)10 

G.  Answer the following questions 

 1. Differentiate between the following: 

 a. High level language and machine level language 

 

High level language Machine level language 

It is the language in which programs are 

written using English like words and 

mathematical symbols. 

It is the language in which instructions 

are given in the form of strings 0s and 

1s. 

Translators are used for converting high-

level language programs into 

corresponding machine language. 

It is understood by the computer without 

any translations. 

It is very easy for programmers to learn 

and use high-level language. 

It is very difficult for programmers to 

write programs in this language. 

 

b. Compiler and Interpreter 

 

Compiler Interpreter 

A compiler converts a program, or a 

source code written in a high-level 

language into the machine language in 

one go. 

An Interpreter is a language processor 

that works by reading and executing the 

source code of a high - level language 

program line by line. 

It stores the converted object code of a 

program. 

It does not save object code of a 

program. 
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c. System software and Application software 

 

System Software Application Software 

System software is required to control 

the operations of a computer system. 

Application software is a set of programs 

designed to help the user to perform 

specific tasks. 

It can be classified into three categories: 

1. Operating System 

2. Language Processors 

3. Utility Software 

It can be classified into two categories: 

1. General Purpose Application 

Software 

2. Specific Purpose Application 

Software    

Examples: Linux, Compiler, Quick Heal, 

WinRAR 

Examples: Word 2013, Oracle, Adobe 

InDesign, Impress 
 

 2 What are the two categories of application software? Name and define them by giving 

suitable examples of each. 

 → Application software can be divided into two categories: 

1. General purpose application software 

2. Specific purpose application software 

 

1. General purpose application software: 

General purpose application software is developed keeping in mind the needs and 

requirements of general people. 

Examples: 

● Word processing software 

● Spreadsheet software 

● Database Management System 

● Desktop Publishing Software 

● Graphics, Multimedia and Presentation Software 

2. Specific purpose application software: 

Specific purpose application software is developed keeping in mind the requirements 

of an organization or an individual. 

Examples: 

● Accounting Management Software 

● Reservation System 

● Human Resource Management System 

● Attendance System 

● Payroll System       

 3. Name any two functions performed by operating system. 

 → 1. Operating system serves as an interface between the user and the hardware. 
2. It ensures that the computer hardware is used in an efficient manner. 

3. It acts as a resource manager by allocating resources to specific programs and 

applications as and when required.  

 4. What is the advantages of an open - source software? Give two examples of open - 

source software. 
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 → Open - source software allows the source code to be accessible to the users and organizations 

so people can improve and adapt it according to their needs and help in fixing the errors. 

Examples:  

● Ubuntu 

● Android 

● Open office 

● Mozilla Firefox 

● Audacity 

● GIMP 

● VLC 

HOTS 

 Complete the following table: 
 

Category of Software Description Example 

Desktop Publishing 

Software 

This type of software is used for designing 

books, journals, brochures, newspapers. 

Adobe InDesign, 

QuarkXPress 

Operating System It serves as an interface between the user 

and the hardware. 

Windows 

Utility Software They are designed to perform 

maintenance work on a computer system 

to help in its smooth functioning. 

WinZip, WinRAR, 

AVG 

Language Processor It translates or converts program in 

assembly and high-level language. 

Compiler, Interpreter 

Specific Purpose 

Application Software 

It is developed keeping mind the 

requirements of an organization or an 

individual. 

Human Resource 

Management, 

Inventory and control 

system 

Open-Source Software It allows the underlying code to be 

accessible to the users and organizations 

so that they may study it, make changes 

to it and build new versions of the 

software incorporating their changes. 

Ubuntu, Android, 

GIMP 
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Chapter: 2 Calculation in Microsoft Excel 2013 

  

Practice Zone (Page no 26) 

 Consider the given worksheet data. Calculate the following based on the given worksheet 

data. 

 1. Amount = Price per unit * Quantity 

 

 2. Total Amount Payable: 

 

Practice Zone (Page no 35) 

 Consider the given worksheet data. Write commands for the following based on the data 

given in the worksheet. 

 

 1. Calculate the total points for each house. 

 → =SUM (B5:F5) 
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 2. Calculate maximum, minimum and average points for the different event. 

 → 1. Average Points Scored: =AVERAGE(B5:B8) [Dance] 

                                         =AVERAGE(C5:C8) [Music] 

                                         =AVERAGE(D5:D8) [Drama] 

                                        =AVERAGE(E5:E8) [Art] 

                                        =AVERAGE(F5:F8) [Discipline] 

2. Maximum Points Scored: =MAX(B5:B8) [Dance] 

                                         =MAX(C5:C8) [Music] 

                                         =MAX(D5:D8) [Drama] 

                                        =MAX(E5:E8) [Art] 

                                        =MAX(F5:F8) [Discipline] 

3. Minimum Points Scored: =MIN(B5:B8) [Dance] 

                                         =MIN(C5:C8) [Music] 

                                         =MIN(D5:D8) [Drama] 

                                        =MIN(E5:E8) [Art] 

                                        =MIN(F5:F8) [Discipline] 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following is the symbol for multiplication in Excel? 

  a) / b) ^ 

  c) * d) & 

 2. An error that occurs when a formula contains invalid data is 

  a) #VALUE! b) #NAME? 

  c) #DIV/0! d) ###### 

 3. Which of the following is the correct way of specifying arguments to a function? 

  a) =SUM [A1:A5] b) =SUM{A1:A5} 

  c) =SUM (A1:A5) d) =SUM (A1-A5) 

 4. Which is the correct way to concatenate two text values contained in cells A1 and B1 in 

Excel? 

  a) =A1 & B1 b) = A1 + B1 

  c) A1 & B1 d) A1 + B1 

B.  Fill in the blanks using the words given in the box. 

 1. The cell references containing values to be used for calculations passed to the function are 

called arguments. 

 2. Excel displays the error value #NAME? When a formula is not spelt correctly. 

 3. The product function is used to multiply the contents of the cells. 

 4. Operators specify the type of operation you want to perform. 
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 5. The AutoSum feature is particularly useful when you want to add numbers in a contiguous 

row or column quickly. 

 6. To calculate the number of numeric entries in a range of cells, you use the count function. 

C.  Write the formula to calculate the following. 

 1. To add the contents of cells B2, B3, B4 and B5 and divide the sum by the contents of cell 

C7. 

 → =(B2+B3+B4+B5)/C7 

 2. To multiply the contents of the cells C12 and C13 and then divide the product by the 

contents of the cell D18. 

 → =(C12*C13)/D18        OR       =PRODUCT (C12:C13)/D18 

 3. To subtract the contents of the cell A6 from the contents of the cell B6 and then multiply 

the difference with the contents of the cell C6. 

 → =(B6 - A6)*C6 

 4. Selecting the maximum value out of a range A1 to B20. 

 → =MAX(A1:B20) 

 5. Calculating average of marks entered in cells E5, F5, G5, H5 and I5. 

 → =AVERAGE(E5:I5) 

 6. Calculating total expenses incurred if expenses are given month-wise in cells A1, B1, C1 

and D1. 

 → =SUM(A1:D1) 

D.  Answer the following questions. 

 1. Define formulas. 

 → Formula is an expression in Excel that contains constants, cell references, functions and/or 

operators that allows you to perform calculations in a worksheet. 

 2. What are operators? List the use of some operators used for calculations in Excel. 

 → Operators are the special symbols such as +, -, &, etc., used for specifying the type of 

operation to be performed. 

 → The different types of operators include the arithmetic and the text operators. 

 → Arithmetic operators: +, -, *, /, ^ 

 → Text operators: & 

 3. What is the significance of AutoSum feature? Name the tab containing this option. 

 → The AutoSum (Σ) feature allows you to calculate the sum of data arranged in contiguous rows 

or column quickly. 
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 → The AutoSum option is available at two places: 

  1. In the Editing group on the Home tab.  

2. In the Function Library group on the Formulas tab. 

 4. Define Functions. Discuss its structure. 

 → Functions are predefined formulas that can be applied directly to perform calculations in 

Excel. 

 → Structure of Function: 

  A function in Excel has three parts. 

1. Equal to sign (=): All functions must start with an equal to sign. 

2. Function Name: It is the name of the function that help us in specifying the type of 

operation to be performed on the values. 

3. Arguments: The cell references containing values passed to a function to be used for 

calculations are called arguments. 

Example:  = SUM (A1:A5) 

HOTS 

 Using the given worksheet, write a function or formula for the following 

requirements: 

 

 1. Total number of books sold in Mumbai. 

 → =SUM (D3:D7) 

 2. Maximum number of ‘Power of Mind’ book sold in all the four cities. 

 → =MAX (C3:F3) 

 3. Average number of ‘New Computers’ book sold in all the four cities. 

 → =AVERAGE (C7:F7) 

 4. Minimum sale of books in city ‘Delhi’. 

 → =MIN (C3:C7) 

 5. What will be the result of the formula =COUNT (C3:E7)? 

 → 15 
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Chapter: 3 Charts in Microsoft Excel 2013 

 

Practice Zone (Page no: 42) 

 Match the following. 

 

 Component of a chart Purpose 

1. Plot area An area containing the chart, axes and gridlines. 

2. Data marker Any symbol such as a bar, an area, a dot or a slice used 

to represent a value in a chart. 

3. Axes The horizontal and the vertical lines that surround the 

plot area used as reference points for measuring the 

data values being plotted on the chart. 

4. Gridlines The horizontal or the vertical lines in the plot area used 

to identify the value of each data point on the chart. 

5. Legend A box containing a unique pattern or color to identify 

each data series on a chart. 

6. Chart area An entire area containing the chart and all its elements. 
 

Practice Zone (Page no 46) 

 Suggest the suitable type of chart for plotting the following. 

 1. To compare the production of various items such as rice, wheat, barley over a period of 

three years. 

 → Column Chart 

 2. To depict the size of items in one data series, proportional to the sum of the items sold 

by a company. 

 → Pie Chart 

 3. To display the trends in the demand of refrigerators over a period of last five years. 

 → Line Chart 

Assessment Zone 

A.  Choose the correct answer. 

 1. Identify the component of the chart helps in identifying various plotted data series by 

assigning a unique color or pattern to a particular data series. 

  a) Chart title b) Axes 
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  c) Plot area d) Legend 

 2. Which of the following charts plot the data series as rings? 

  a) Bar Chart b) Line Chart 

  c) Pie Chart d) Doughnut Chart 

 3. Identify the chart that uses connecting dots to depict the trends over a period of time. 

  a) Line Chart b) Pie Chart 

  c) Bar Chart d) Doughnut Chart 

 4. The horizontal or the vertical lines in the plot area that help us in easily identifying the 

value of each data point on the chart is called  _____________. 

  a) Gridlines b) Axes 

  c) Chart Title d) Legend 

B.  Fill in the blanks using the words given in the box. 

 1. The option to add charts in the worksheet is present under the Insert tab. 

 2. Any symbol such as a bar, an area or a slice used to represent a value in a chart is called data 

marker 

 3. The bar chart represents values on the horizontal axis and categories on the vertical axis. 

 4. The design tab shows inbuilt chart styles. 

 5. The relationship of individual items to the sum of all items in the series can be represented 

using the pie chart. 

C.  State whether the following statements are True or False. 

 1. Doughnut chart can plot only one data series. - False 

 2. Once added, we cannot change the look and feel of the chart. - False 

 3. We can give titles to the x-axis and y-axis. - True 

 4. We can change the location of the placement of the chart. - True 

 5. Bar charts represent categories on the y-axis and values on the x-axis.  - True 

D.  Answer the following questions. 

 1. What is a chart? What are the advantages of charts? 

 → Charts are graphical representation of worksheet data. 

 → Charts makes it easier for users to quickly understand, compare and find patterns and 

relationships between worksheet data. 

 2. What is the use of gridlines and legends in a chart? 
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 → Gridlines: The horizontal or vertical lines in the plot area of a chart. 

 → Legends: A box that helps in identifying various plotted data series by assigning a unique 

color or pattern to a particular data series in a chart. 

 3. What is the difference between a bar chart and a column chart? 

Bar Chart Column Chart 

It displays the comparisons among 

individual items as sets of horizontal bars. 

It is used to depict comparisons among 

different items of data or changes in data 

trend over a period. 

The values are represented on the horizontal 

axis whereas categories are represented on 

the vertical axis. 

The values are represented on the vertical 

axis whereas categories are represented on 

the horizontal axis. 
 

HOTS 

 Study the following chart based on the number of packages sold by a Tours and Travels 

company to the various destinations in the last four months and answer the questions that 

follow: 

 1. Identify the type of chart. 

 → Column chart 

 2. A legend has been placed in the chart. Identify its position. 

 → Right side. 

 3. What are the numbers on top of every bar known as? 

 → Data label 

 4. What are the lines running across the plot area known as? What is their use? 

 → Gridlines 

 → They are used to identify the value of each data point on the chart. 

 5. Identify two months in which the company sold maximum number of packages for 

Mauritius. 

 → Feb and March 

 6. Name the tab and option you will use to change the style of the chart. 

 → Chart Styles group on Design Tab 
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Chapter: 4 Advanced Features of Microsoft Excel 2013 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following features in Excel lets you format the cells when the cell 

contents satisfy a particular condition? 

  a) Sorting b) Custom Filtering 

  c) Conditional Formatting d) Cell Formatting 

 2. Which of the following statements holds true for custom filtering in Excel? 

  a) This option lets you change the background colour on the basis of satisfaction of a 

condition. 

  b) This option lets you view selective rows that satisfies more than one condition 

for a column. 

  c) This option lets you arrange data in ascending or descending order. 

  d) This option lets you generate a series of data. 

 3. Which of the following statements is not true about sorting data in Excel? 

  a) You can sort data in rows on the basis 

of text, numbers or dates. 

b) You can sort data in ascending or 

descending order. 

  c) You cannot sort data by more than 

one column. 

d) You can exclude header rows 

from sorting. 

B.  Fill in the blanks using the words given in the box. 

 1. The conditional formatting feature of Excel lets you apply formatting to a cell only when 

the value in the cell satisfies a given condition. 

 2. The option to apply conditional formatting is available on the home tab. 

 3. The filtering features lets you temporarily hide the rows that do not meet the specified 

condition. 

 4. Using custom filter, you can display data that satisfies more than one condition for a 

column. 
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C.  Answer the following questions. 

 1. What is the use of sorting feature in Excel? How is it different from the Filtering 

feature? 

 → Sorting allows you to arrange data in a particular order whereas filtering allows view 

selective data that meets a certain criterion. 

 2. What is custom filtering? 

 → Custom filter is used to display data that satisfies more than one condition for a column. 

 3. Discuss the two ways in which you can specify the conditions when using the filtering 

feature? 

 → Number Filter and Text Filter are the two ways in which you can specify the conditions 

when filtering data. 

 → Number filter appear as we are filtering on the basis of number-based column. 

 → Text filter appear as we are filtering on the basis of text-based column. 

 4. How is conditional formatting useful to us? Name the tab that contains the option for 

applying conditional formatting. 

 → Conditional formatting is a feature in Excel that allows apply formatting, such as cell 

shading or font color to a cell when the cell contents satisfy a given condition. 

 → Conditional formatting option is available in Styles group on the Home tab. 
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HOTS 

 Study the given image and answer the questions that follow: 

 

 1. Which feature of Excel will you use to 

arrange the data in the descending order 

of names of students? 

 

→ Sorting 

2. Which feature of Excel will you use to view 

only the names and grades of students who 

have opted for ‘Computer’ as an activity? 

→ Filter 

3. Which feature of Excel has been used to 

highlight the cells having Grade ‘A’ in the 

column ‘Grade’? 

→ Conditional Formatting 
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Chapter – 5 Looping Statements in QBASIC 

 

Practice Zone (Page no 77) 

 Consider the following programs and choose the correct answer. 

 1. FOR I = 1 TO 10 STEP 2 

PRINT I 

NEXT I 

 → The output of the program is: All odd numbers from 1 to 10 

 2. FOR A = 50 TO 1 STEP -1 

PRINT A 

NEXT A 

 → The output of the program is: Numbers from 1 to 50 in descending order 

Practice Zone (Page no 81) 

 Write a program to display your name multiple times using DO WHILE … LOOP. 

  REM write a program to display your name multiple times using DO WHILE ... LOOP. 

CLS 

i = 0 

DO WHILE i <= 10 

    PRINT "My name is Prutha" 

    i = i + 1 

LOOP 

Assessment Zone 

A.  Choose the correct answer. 

 1. Which of the following looping statements is most suitable when several statements 

have to be executed a fixed number of times? 

  a) DO WHILE …LOOP b) DO UNTIL … LOOP 

  c) FOR … NEXT d) None of these 

 2. The default value of the step value is ___________ 

  a) 1 b) 0 

  c) -1 d) None of these 

 3. The step value can be __________ 

  a) a positive value b) a negative value 

  c) a decimal value d) All of these 
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 4. How many times will the following loop be executed? 

X = 0 

DO WHILE X > 10 

PRINT “*” 

LOOP 

  a) 10 b) 5 

  c) 0 d) 9 

 5. In a FOR … NEXT loop, if the final value is less than the initial value, then the 

STEP value should be __________ 

  a) Positive b) Negative 

  c) Zero d) None of these 

 6. What will be the output for the following program? 

FOR V = 1 TO 10 

NEXT V 

PRINT V 

  a) 1 b) 10 

  c) 11 d) None of these 

B.   Write the value taken by the control variable in the following FOR 

statements. 

   

FOR statement Values 

1. FOR X = 5 TO 10 STEP 2 5, 7, 9 

2. FOR X = 20 TO 5 STEP -5 20, 15, 10, 5 

3. FOR X = 100 TO 105 100, 101, 102, 103, 104, 105 

4. FOR X = 4 TO 6 STEP 0.5 4, 4.5, 5, 5.5, 6 
 

C.  Find errors in the following programs and write the correct code. 

 1. FOR R = 1   , 5 

PRINT R 

NEXT A 

→ FOR R = 1 TO 5 

PRINT R 

NEXT R 

 2. X = 1 

DO   LOOP    X < 5 

PRINT X 

X = X + 1 

WHILE 

→ X = 1 

DO WHILE X < 5 

PRINT X 

X = X + 1 

LOOP 
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D.  Answer the following questions. 

 1. What is a loop? How can you create loops in QBASIC? 

 → A loop is used to repeat the execution of a group of statements many times. 

 → We can create loops in two ways in QBASIC: 

  1. FOR … NEXT 

2. DO … LOOP 

a. DO WHILE … LOOP 

b. DO UNTIL … LOOP 

2. What is the use of step value in a FOR … NEXT loop? 

→ Step value is the value by which the counter variable is incremented or decremented every 

time the loop body is executed. 

→ It can be a positive or a negative value, but it cannot be zero. 

→ The step value is optional. 

→ The default step value is 1. 

3. How is a DO WHILE … LOOP different from DO UNTIL … LOOP? 

→ The DO UNTIL … LOOP is similar to the DO WHILE … LOOP, the only difference 

between the two loops is that in the DO UNTIL … LOOP, the execution of the loop 

continues as long as the condition is false. 

4. Give the significance of the EXIT DO and EXIT FOR statement. 

→ You can exit from FOR … NEXT loop using EXIT FOR statement. 

→ You can exit from DO … LOOP using EXIT DO statement. 

5. What should be the step value in the following code? 

REM Display multiples of 3 

FOR I = 3 TO 30 STEP  ___ 

NEXT I 

→ 3 

6. The following program was written to display even numbers between 4 to 44 in reverse 

order. The program is not giving the desired output. Identify and correct the mistake 

in the program. 

→ REM Program to display even numbers. 

FOR X = 44 TO 4 STEP 4     -2 

PRINT X 

NEXT X 
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HOTS 

Study the image and answer the questions that follow. 

There are 10 residents in a society. The program deals with the residents of the society. 

 

 

1. What does the above program do? 

→ The program shows the total number of car owners. 

2. What is the step value in the FOR … NEXT loop? 

→ 1 

3. How many times will the loop run? 

→ 10 

4. What statement should be added to the program to 

display the count of residents who do not own a car? 

→ PRINT “Residents who do not own a car:”; 10 – count 
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